
Overview 

Thank you for downloading Multimedia Manager! 

Multimedia Manager is an all-in-one multimedia software that lets you view image 
files, play audio files, and manage your files easily. It supports many popular 
multimedia formats: BMP, JPG, GIF (including animated GIF), TIF, TGA, PNG, PCX, 
PSD, PCD, ICO, WMF, WPG, MID, WAV, RMI, AVI, MOV, MPG, DAT, ANI, and CUR.

It also incorporates quite a lot of powerful and outstanding features like advanced 
image manipulation support, list box feature, built-in ZIP support, internal text/binary 
file viewer, email support, dockable image toolbar, and many more.

You can browse this help file by pressing the [<<] or [>>] buttons on the help toolbar. To 
see help topics, press [Contents], or press [Index] to see help index.



Features Summary

· Extensive supports for all popular graphics formats:
- BMP (Standard and RLE Compressed Windows Bitmap)
- JPG (JPEG)
- GIF (Compuserve GIF, static and animated)
- PNG (Portable Network Graphics)
- PCX (ZSoft PCX)
- PCD (Kodak PhotoCD)
- PSD (Adobe Photoshop 3.0) 
- TIFF (Tagged Image File Format)
- TGA (Truevision Targa)
- WPG (WordPerfect Graphics)
- WMF (Windows Meta File) 
- ICO (Windows Icons)
- CUR (Windows Cursor)
- ANI (Animated Windows Cursor)

With fast image decoding and best image quality plus the ability to stretch, tile, flip, rotate, resize, 
zoom, and print the image easily. 

· Built-in audio and video player
Supported    formats: MID, WAV, RMI, AVI, MOV, MPG and DAT.
MOV, MPG and DAT file require properly installed MCI drivers to play.

· User friendly interface that help you to manage files easily
It is designed to be easy to use for novice users and also to be efficient and flexible for experienced 
users. 

· Convert images to BMP, JPG, GIF, PNG, PCX, PSD, TIF, TGA, WPG, and WMF easily.
Save resolution: monochrome, 16 color, 256 color, true color, or grayscale.
Supported TIFF compression method: CCITT, CCITT Group 3, CCITT Group 4, LZW or PACKBITS.

· Full clipboard support to copy image to clipboard or paste image from clipboard

· Advanced slide show feature
You can choose to run slide show whether in manual or automatic mode, display images in random 
order, stretch, tile or zoom the image on fly.

· Set any image as your desktop wallpaper easily
You can use any graphics file supported by Multimedia Manager as desktop wallpaper. Multimedia 
Manager will handle the conversion issue automatically.

· Full DDE support

· Easy installation and uninstallation

Plus all these powerful features:

· Advanced image manipulation feature      
Since version 1.2a, you can add special effects and filters to manipulate image (bleed, blur, 

border fade, dark, sharpen, soften, engrave, gamma correction, halftone, jiggle, mosaic, oil paint,    polar, 
spray, wave, and many more). Very cool! 



· Ability to resize multiple images at once      
With this new feature, you can convert and resize multiple images all at once. This feature is 

particularly useful if you want to create thumbnail images for your web page. Since v2.0, you may resize 
images proportionally (e.g. 50% from their original size).

· Cool and versatile image toolbar to manipulate images quickly 
The toolbar is dockable and floatable so you can place it anywhere you like.

· Built-in ZIP support 
Since version 2.0, Multimedia Manager's incorporated full ZIP support (PKZIP compatible) to 

compress files to ZIP, extract files from ZIP file and view ZIP file as well. All compression settings like 
speed (normal, maximum, fast, fastest or none), action (add all files, update archive, freshen archive), zip 
comments, recurse directories, disk spanning, zip comment and zip password are fully configurable.

· Built-in text/binary file viewer 
You can view file contents as text or binary by right clicking the file and select "View As Text" or "View 
As Binary".

· Internet/Email support 
You can send your multimedia files over the Internet as email attachments quickly using Simple 
Messaging API (MAPI).

· Powerful files management capability
Combined with ZIP support, list box feature and drag'n drop support, Multimedia Manager is a versatile 
and reliable file manager to manage your files.

· List box to ease you managing files    
With this unique feature, you can select files from many directories and then you can copy or 

move those files at once. 

· You can create collection of favorite files

· Drag and drop support  
You can drag and drop files FROM Multimedia Manager TO Explorer, or vice versa! 

· You can drop any image, audio/video clip, or cursor file supported by Multimedia Manager to the 
display window to open it quickly 

· Auto skip feature
With this feature you can view an image file and quickly load the next/previous image file in the current 
directory skipping other files with different type. Very handy.

· Explorer support
You can run Explorer to explore any folder by right clicking the folder and select Explore Folder.. 

· Bookmark feature to mark your most used directories



System requirements

To run Multimedia Manager properly, your system should have at least:

· Intel 80486DX processor (Pentium or higher processor is recommended for faster image processing)
· Microsoft Windows 95/98/NT or higher.
· 16 MB RAM (32 MB recommended)
· VGA card (2 MB recommended)
· Sound card (if you want to play audio file)
· Properly installed MCI drivers to play MOV, MPG and DAT video files
· Keyboard and mouse



Installation

Normally, Multimedia Manager is distributed in a single executable file that you need to run to install the 
program.

You can install newer version in the same directory where you installed the previous version, the 
installation program will check the current version and keep the program configuration.

NOTE: If you download Multimedia Manager from Simtel.Net or ZDNet Software Library, it is packed in a 
ZIP file rather than a single EXE file, so you need to unzip it first using PkUnzip or WinZip, then run the 
Setup program.



Year 2000 Compliance

Tropical Wares warrants that Multimedia Manager shall commit no date-related error due to its operation 
within or between the 20th and 21st centuries, insofar as the underlying operating system and hardware 
function correctly, such correct function including, but not limited to, the accurate implementation of the 
Win32 application programming interface as defined by Microsoft.

For information regarding year 2000 compliance of Microsoft's operating systems, please see the 
Microsoft Year 2000 Resource Center at http://www.microsoft.com/year2000



Version History

Please see "WHATSNEW.TXT" file for complete version history of Multimedia Manager.

Click  if you want to view the file now.



Getting Started

Here is Multimedia Manager's main window. Click on the picture to learn more.

 

If you want to learn more about managing files, click below:
Working with files
Using list box to manage files

Or if you want to know how Multimedia Manager handles multimedia file, click below:
Viewing image file
Playing audio or video file
Viewing cursor file



Files filter

You can display only certain files you want to manage in the file list box. 
Example, you want to display BMP files only. Select "Change Filter" in the View menu and type *.BMP 
in the filter box then press OK button. After that, only BMP files will be displayed in the file list box.



File list box
File list box lists files in the active directory. Here you can view image, cursor, audio and video files. 
You can change the files filter by selecting "Change Filter" from the View menu. To manage your files 
quickly, press your right mouse button to access pop-up menu.



Path combo box

Use this to change active drive or directory. Press this button  to change to previous level directory



Toolbar
Here you can perform quick access to change directory, refresh directory, set files filter, create new 
folder, copy files, and other common tasks.



Working with files

Quick step by step procedures to manage files:
· Change to directory where you will manage your files and set files filter if you want to filter certain files.
· Select files (by holding <Shift> key while moving arrow keys or holding <Ctrl> and left click to select 

multiple files at once) 
· Drag them to the list box under the file list box (or just press Insert to do so) 

· Click  in the list box toolbar and select the action that you want to do on those files (copy, move, 
delete, batch conversion, slide show, compress to ZIP, etc).

Tips:
· You can drag and drop files from Multimedia Manager to Explorer or vice versa 
· Use bookmark to switch between directories quickly
· Utilize the list box feature to store multiple files easily
· Select "Tool - MS-DOS Prompt" to go to DOS prompt if you want to format disk or check disk free space
· You can open more than one instance of Multimedia Manager if you like to.

To learn more advanced tips, click below:
Using list box to manage files
Using filters to select files
Using bookmark
Keyboard Shortcuts



File status
You can see the selected file status: its path and type.



Main menu
This is Multimedia Manager's main menu. Just click the menu title or press <Alt> and the underlined 
character from the menu title you want to open.



Status bar
Here you can see the number of selected files in the file list box and their size. Also, if you open an 
image file, the image information will be displayed under the display window.



Display window
Display window is place where image will be displayed to. Here you can scroll the image by dragging 
your mouse and you can also access image pop-up menu by right clicking your mouse.



List box
The list box can be used to ease you managing files, especially if want to manage lot of files in many 
directories. On the left side is the list box toolbar to provide quick access to manage the list box 
contents. See also: What is list box?



Caption bar
This caption bar has three additional buttons beside the minimize, maximize and close button. The first 
additional button is used to open Windows Start menu, the second to roll up the main window and the 
third button can be used to make the main window always stay on top.



Image toolbar
With this toolbar you can change the image appearance (tile, stretch, center, zoom, rotate, flip, etc). You 
can also move the toolbar position by dragging it to the new location.



Converting and saving images

Multimedia Manager can save image and convert multiple images to BMP, JPG, GIF, PNG, PCX, PSD, 
TIF, TGA, WPG, and WMF with various options. Select the images you want to convert, and select 
"Convert Images" from File menu.

As you can see above, you can configure the conversion settings: 
· save resolution (monochrome, grayscale, and 4/8/16/24/32 bit color)
· save quality for JPEG 
· image resizing

    You can also resize multiple images at once by checking the "Resize Image" or "Resize Image 
Proportionally" checkbox. This is particularly useful when you want to create thumbnail images for your 
web page.

Tip: you may press F3 to open a dialog to select file/directory faster

NOTE
Some image formats cannot be saved in true color or 16/256 color resolution (e.g. GIF format only 
supports 16, 256, or grayscale color)



Configuring desktop wallpaper

You can use any image supported by Multimedia Manager as desktop wallpaper. Right click the image 
file name and select "Set As Desktop Wallpaper" or select "Configure Desktop Wallpaper" from the 
Tools menu.

 

Select the wallpaper position you want (tile, center, fit to screen, or even at any position). 
Moreover, you may use not only BMP file for your wallpaper but also any image supported by 
Multimedia Manager (JPG, GIF, PNG, PCX, TIF, TGA, etc). Multimedia Manager will handle the 
conversion problem for you.

Tip: you may press F3 to open a dialog to select file/directory faster

NOTE
· To fit your wallpaper to screen, you need Microsoft Plus installed in your system.
· If you set Origin X or Origin Y to 0 then your wallpaper will be centered vertically / horizontally. 
· The Custom Position feature will not work under Windows 98 (and NT 5.0 perhaps) since Microsoft has 

removed this capability with no obvious reason since Windows 98 released.



Using list box to manage files
What is list box?

Click on the picture for more help



What is list box?
List box is like a shopping basket you use while shopping in supermarket. You can put anything you 
want to buy there. In Multimedia Manager, list box is used to hold files that you have already selected in 
the file list box. Those files in the list box can be copied, moved, deleted, or displayed as slide show. 
The list box contents can be also saved as collection file.
This list box feature might be a new and unique concept for you, but if you have tried it, you may found 
it very powerful and helpful in managing files, especially if you want to work on lot of files in many 
directories.



Using list box pop-up menu

Copy copy all files in list box

Move move all files in list box 

Delete delete all files inthe list box

Convert Images convert all image files in list box (use this to batch convert mulltiple 
images)

Slide Show view all images in list box as slide show

Compress To ZIP compress all files in list box to ZIP

Send As Attachments send all files in list box as email attachments

Remove From List Box remove selected files from list box

Clear List Box remove all files from list box

Files with this commands, you can create collection file
Save To File save list box contents to collection file
Load From File load list box contents from collection file
Append From File append list box contents from collection file

Show Toolbar change list box's toolbar position (left, right or invisible)



Using filters to select files

You may select or deselect files in the file list box with filters to ease you managing certain files.

You can specify multiple filters separated by a colon (,) or semicolon (;).
Example: *.GIF, *.BMP; MUSIC*.MID



Copying/moving files

To copy or move files to another directory, select the files you want to copy/move and select "Copy To" or 
"Move To" from File menu.

You can copy/move files to any directory by using this dialog. You can enter the target directory in many 
ways: type it at the edit box, pick one from history list, or pick one from bookmark list. If the directory 
doesn't exist, you will be prompted to create it automatically.

Tip: you may press F3 to open a dialog to select target directory faster



Viewing image file

Multimedia Manager will load an image file and display it in the display window automatically if the 
"Auto open file" checkbox in Options - General menu is checked. Otherwise you must press <Enter> or 
double click the file to load and display it in the display window.

Supported formats are: BMP, JPG, GIF, TIF, TGA, PNG, PCX, WMF, WPG, PCD, PSD, and ICO. 

After the image displayed in display window you can also access the image pop-up menu by clicking 
the image with your right mouse button.

Here you can do anything you want such as stretching, tiling, centering, saving, resizing or zooming the 
image. 

As you can see here, you can set the image as desktop wallpaper, filip or rotate image, configure image 
brightness, print or scan image easily. Select "Filters And Effects" to add filters and special effects.

Since version 2.0, Multimedia Manager's provided a more convenient way to view images. You can 
select the image command directly from image toolbar. To move the toolbar position, just drag the 



toolbar to a new location.

See also:
Manipulate image



Manipulate image

This is one of the  features in Multimedia Manager. To manipulate image, right click on the image 
and select "Advanced - Filters And Effects".

You can select the kind of effects you like from the tab sheet (bleed, blur, border fade, blur, dark,    curl 
page, engrave, gamma correction, halftone, jiggle, mosaic, oil paint,    polar, spray, wave, ...).

Toolbar Command
Hide Selection hide the rubberband
Reset Selection reset the rubberband to full image
Reload reload image
Preview preview this effect before applying it
Apply apply the effect to master image
Stop stop processing the image
Close and Save apply the effects to master image

After you manipulate the image, don't forget to save it by selecting "Save As" from the image toolbar or 
from the image pop-up menu, because the changes are not automatically saved to the image.



Playing audio or video file

Just like viewing image file, you may also play audio (MID, WAV, RMI) and video (AVI, MOV, MPG, 
DAT) file. To play MOV, MPG and DAT file require properly installed MCI drivers in your system. 

Use this media player panel to control playback of played file.

NOTE: For best result, it's recommended to use your default MPEG player (e.g. ActiveMovie, 
SoftMPEG, or XingMPEG Player) rather than Multimedia Manager to play MPG or DAT file.



Track bar
You can change the position of current played media here.



Playback control
Here you can play, pause, rewind, or step the played media.



Load previous file
Click this button to load previous file with same type.
Example: if you were playing an audio file, clicking this button will load previous audio file in current 
directory.



Viewing cursor file

You can view cursor file (CUR or ANI) by selecting one and see your mouse pointer changes.



Load next file
Click this button to load next file with same type.
Example: if you were playing an audio file, clicking this button will load next audio file in current directory.



Media status
Here you can see opened media status and also the position and the length of opened media.



Click here to configure audio/video options.



Using bookmark

Bookmark feature is one of the favorite features in Multimedia Manager. It is just like bookmarks in 
Netscape or Internet Explorer. With this you can switch between directories quickly. 

Press <Ctrl+D> to add current directory to bookmark list and press <Ctrl+B> to list and manage your 
bookmarks (just like in Netscape Navigator). 

Nine last used bookmarks will be saved in Bookmark menu so you can jump quickly to a bookmark by 
selecting it in the Bookmark menu. 



Keyboard Shortcuts

Special Shortcuts (can be used while browsing files in the file list box)

Hold <Shift> or <Ctrl> while pressing arrow keys to select multiple files 

Ctrl + Space deselect current file 
Insert add selected files to list box 
Ctrl + Insert remove selected files from list box if exist 
Enter open selected file with default associated program or change directory if it is a folder
Backspace back to previous level directory 
Shift + Delete delete selected files without sending them to recycle bin

You can also use your mouse to drag files from file list box and drop it into the list box, or vice versa. 

Special Shortcuts (can be used while browsing files in the list box)

Hold <Shift> or <Ctrl> while pressing arrow keys to select multiple files in the list box

Delete remove selected files from list box 

Another HOT Shortcuts

Press <Alt> and arrow keys (Up, Down, Left or Right) to load next / previous file with same type.
If you are viewing an image, than pressing <Alt> + <down arrow> will search next image file in current 
directory, skipping other files.

Ctrl + Z clear list box contents
Ctrl + F8 copy all files in list box 
Ctrl + F7 move all files in list box 
Ctrl + Delete delete all files in list box 
Ctrl + F6 convert all image files in list box

Ctrl + P play / pause selected file (for audio/video file)
Ctrl + Y show / hide player panel

Ctrl + V save image
Ctrl + H stretch image
Ctrl + T tile image
Ctrl + R center image
F4 view image in full screen 
Plus key (+) zoom in image
Minus key (-) zoom out image
Multiply key (*) reload image
Ctrl + Plus key increase image brightness
Ctrl + Minus key reduce image brightness

Files Shortcuts

Ctrl + N create new folder 
Ctrl + X close file



F3 change directory 
F8 copy selected files (in file list box) 
F7 move selected files 
Delete delete selected files 
F6 convert selected files
F2 rename file 
F9 open selected file with default associated program 

Edit Shortcuts

Ctrl + C copy image to clipboard 
Ctrl + A select all files 
Ctrl + S select files with filters 
Ctrl + I invert selection

View Shortcuts

F5 refresh directory 
Ctrl + F change files filter 
Ctrl + O configure program options 

Bookmark Shortcuts

Ctrl + D add current directory to bookmark 
Ctrl + B list all bookmarks and select a bookmark to go to 

Tools Shortcuts

Ctrl + E run Windows Explorer
Ctrl + W configure desktop wallpaper 
Ctrl + L run slide show on images in current directory 
Ctrl + M go to MS-DOS prompt



Drag and drop support

These are some examples how to use the drag and drop support in Multimedia Manager:
· You can drag and drop file from any window (Explorer, desktop, etc) to Multimedia Manager's icon on 

the desktop. If the file format is supported, the file will be opened automatically.
· You can drag and drop files from Multimedia Manager to any window (Explorer, desktop, etc). E.g. if 

you drag and drop files from Multimedia Manager to another folder in Windows Explorer, this will copy 
the files to that folder.

· Also, you may drag and drop files from any window to Multimedia Manager. The result depends on the 
drop target. If the drop target is Multimedia Manager's display window, the file will be opened quickly. If 
the drop target is Multimedia Manager's file list box, the files will be copied (also depends on the folder 
where you drop the files). Or, if you drop the files to Multimedia Manager's list box, the files will be 
added to the list box.

Tips: you can also drag and drop file from the list box to the display window if you want open it quickly.



Ordering Information

Multimedia Manager is available for sale here:

http://www.tropicalwares.com/mmanager.html

Ordering Multimedia Manager is easy, fast, and most importantly, secure. All major credit cards (Visa, 
Mastercard, Amex, and Discover) are accepted. Once your order has been processed, you will receive a 
link from which you can download your own fully-licensed copy of Multimedia Manager immediately.

We also accept ordering via PHONE, FAX, CHECK, and MONEY ORDER, provided by DigiBuy 
(Maagnum Commerce). Just follow the order link above and choose your preferred ordering method in 
the order form.

The price for the licensed version is $24.95 USD.

Ordering Multimedia Manager provides you with the following benefits:
· Immediately receive a licensed version with no reminder screen and allow unlimited uses
· Unleash all the powerful features of Multimedia Manager (edit/save image and ZIP compressor 

features)
· Priority technical support
· Access to the secure update area where you can get free updates for your Multimedia Manager easily
· Email notification of updates and announcements
· A good feeling that you have supported the development of Multimedia Manager

If you encounter any ordering, payment, or download problem, please contact:
sales@tropicalwares.com.

Thanks in advance for purchasing Multimedia Manager!

Note: Pricing information is subject to change – please check our web site for the latest pricing 
information. 



Trial Version Information

A fully-functional trial version of Multimedia Manager is available for free download here:
http://www.tropicalwares.com/mmanager.html

The trial version is fully functional. It means that you can try out all the features freely, not crippled at all. 
This way, you can explore and evaluate the program thoroughly to find out if it's useful and suitable for 
you.

However some limitations apply:
· You can only use it for 50 uses
· Limited up to 5 images that can be converted or saved in one session
· You cannot save the edited image (using advanced filtering and special effects)
· The ZIP compressor is disabled (cannot add/compress files to ZIP). However, you can still extract or 

view ZIP files using the trial version of Multimedia Manager freely.
· After 50 uses, you can still use the program but it will terminate automatically after 30 seconds or less.

The limitations are intended just to encourage and remind you to purchase the licensed version if you like 
and enjoy the software.

If you have any question or need assistance during the evaluation period, please feel free to contact us 
here: support@tropicalwares.com. We'd be glad to help you and answer your questions.

See also:
Ordering Information



License Agreement

Multimedia Manager
Copyright © 1997-1999 by Tropical Wares.
All rights reserved. 

You should carefully read the following terms and conditions before using this software. Unless you 
have a different license agreement signed by the author, your use of this software indicates your 
acceptance of this license agreement and warranty. 

Distribution 

Provided that you verify that you are distributing the evaluation/trial version (select About from Help 
menu to check) you are hereby licensed to make as many copies of the evaluation version of this 
software and documentation as you wish; give exact copies of the original evaluation version to anyone; 
and distribute the evaluation version of the software and documentation in its unmodified form via 
electronic means. There is no charge for any of the above. 

You are specifically prohibited from charging, or requesting donations, for any such copies, however 
made; and from distributing the software and/or documentation with other products (commercial or 
otherwise) without prior written permission. 

If you want to put the evaluation version of this software on a freeware/shareware CD-ROM or other 
compilation, please contact us before doing so, to be sure that you are not including old or incomplete 
stuff in the compilation. We would also appreciate it if we'd get a free copy of the CD-ROM.

You may not distribute the registered/licensed version to anyone else.

Registered/Licensed Version

One registered copy of Multimedia Manager may either be used by a single person who uses the 
software personally on one or more computers, or installed on a single workstation used 
nonsimultaneously by multiple people, but not both. 

You may access the registered version of Multimedia Manager through a network, provided that you 
have obtained individual licenses for the software covering all workstations that will access the software 
through the network. For instance, if eight different workstations will access Multimedia Manager on the 
network, each workstation must have its own license, regardless of whether they use Multimedia 
Manager at different times or concurrently. Site license can be obtained which covers each workstation 
at one location.

This software is provided 'as-is', without any express or implied warranty.    In no event will the 
author be held liable for any damages arising from the use of this software. This software has 
been written with great care but we do not warrant that the software is error free. You may not 
attempt to reverse compile, modify, translate or disassemble the software in whole or in part.



Known Issues

Video playback problem

· We found problem when trying to play MPG or DAT file on a PC with MPEG card MP2000. We haven't 
tested it with other MPEG card. The solution is by turning off the 'Auto open DAT or MPG file' option in 
Options - Audio/Video menu, so the program will not auto open DAT or MPG file. 

· We suggest you to use default associated program instead (e.g. your default MPEG player or 
XingMPEG player) to play MPG or DAT file.

· If you pause the movie and drag the player panel across the display window, the display will corrupt. 
After the movie resumed, the display will be restored.

Other than this problem, there is no other known problem yet. If you encounter any problems or bugs, 
please inform usand also send us your system configuration information (VGA card type, display 
resolution, O/S version, etc).



Feedback and support

As a user of Multimedia Manager, we'd be glad to provide you with full technical support. If you need 
any help or just want to send your suggestions or comments, feel free to contact us. All emails should 
be replied within 24 hours or less.

Send your email to: 
support@tropicalwares.com

Visit Tropical Wares to get the latest version:
http://www.tropicalwares.com



Other software

If you enjoy Multimedia Manager, we'd like to invite you to try out another fine products from Tropical 
Wares...

WallMaster Pro - $24.95 USD
http://www.tropicalwares.com/wallpro.html
WallMaster Pro offers you total and complete management of your wallpaper collections. With WallMaster 
Pro, you can use any of your favorite images (BMP, JPG, GIF, PNG, TGA, PCX, PCD, PSD, WMF, WPG, 
ICO, and CUR) as your desktop wallpaper easily. With easy-to-use control panel interface and full 
context-sensitive help, you can surely master your own desktop wallpaper in just a few minutes! 

WallMaster Standard - FREE (POSTCARDWARE)
http://www.tropicalwares.com/wallmast.html
WallMaster inherits the basic key features of its commercial brother, WallMaster Pro. You can program the 
desktop wallpaper to change at a specified time interval (e.g. every 30 minutes) and customize the 
wallpaper position (tile, center, fit to screen, auto fit, custom) easily. It also lets you to use JPG, GIF, PNG, 
PCX, TGA, PCD and ICO images as desktop wallpaper. If you are not ready to purchase the commercial 
version, feel free to grab this standard (free) version.

With all the outstanding features, WallMaster has earned many awards and highest ratings on the earth 
such as 5-Star Editor's Pick on ZDNet, two times Preston's Pick for April and August 1998, 6-Duckies on 
NoNags, 4-Star rating on Freeware32, Top Download on SoftSeek, and many more... 



Credits

First of all, we sincerely want to thank all of you who have purchased Multimedia Manager. Your 
supports have helped us to improve the software much better and useful.

We would also like to thank these people who have reported bugs and sent their ideas:
Indy "OveRDoZe"
Mike Simmonds
Harvey Lambert 
and many others...

Also, thanks for all of you that have sent us nice encouraging comments about Multimedia Manager!



Collection file
The collection file is used to store your favorite files so you can view or play them anytime you want. It 
is like playlist in your CD player software. The file is saved in ASCII format (*.MCL) and you can modify 
it easily to fit your need.



Uninstall Multimedia Manager

Multimedia Manager provides easy uninstallation through the Control Panel Add/Remove Programs 
facility. You can uninstall it simply by following these steps:

· Close Multimedia Manager if you are running it now.
· Click here  to open the Control Panel Add/Remove Programs applet.
· Find out Multimedia Manager entry in list and select it.
· Close this help file. Otherwise uninstaller cannot delete it from your system.
· Press Add/Remove button to start removing the application and follow the instructions on screen.

Please tell us the reason that cause you want to uninstall this software. Perhaps we can solve it to fit your 
need. However, thank you for trying Multimedia Manager.



Preview window
In this window, you can preview the image you want to manipulate. You can select a region on the 
image by resizing or dragging the rubberband.



Use this button to add selected files from the file list box to the list box.
Tips: You can also perform the same task by dragging the selected files from the file list box and drop 
them on the list box.



Use this button to remove all selected files from the list box.
Tips: you can do this by dragging the selected files from the list box to the file list box.



Use this button to add all files from the file list box to the list box.



Use this button to remove all files from the list box (clear list box contents)
Tips: you can also do this by pressing Ctrl + Z.



Use this button to access list box pop-up menu to manage those files in the list box.



These are the files that you can copy, move, delete, batch convert or view as slide show



Associate file types

If you want to utilize the DDE feature, you must associate certain file types with Multimedia Manager. You 
may prefer to associate some image file types (JPG, GIF, etc), so then you can open them quickly from 
Windows Explorer by double clicking the file name.

Select "Associate File Types" from Tools menu to do so.

If you enable the image editing and printing option, you can right click the file name from Windows 
Explorer to display the shell context popup menu like this:

You can select "Display" to display the image using Multimedia Manager. Or you can select "Edit Image" 
or "Print Image" to edit or print the image quickly.





Compress files to ZIP

You can easily compress files to ZIP directly by right clicking the files (on the file list box or the list box) 
then select "Compress To ZIP".

You may configure the compression settings as you like.

Tip: you may press F3 to open a dialog to select file/directory faster

Base directory the path stored in the ZIP file will be relative to the base directory

Action Add (and replace) files
All selected files are added to the archive, whether they are already present in the 
archive or not. If a file to be added is already present in the archive, the file inside 
the archive will be replaced.

Update (and add) files
Same as "Freshen existing files", but adds new files to the archive if they are not 
already there.

Freshen existing files
Only files that are more recent than those already in the archive will be replaced. 
Does not add any new files to the archive.

Compression normal, maximum, fast, super fast, or none

Comment put the comments you want to add to the archive here (max. 255 characters)

Password to encrypt the archive with password (max. 80 characters)

Options Span multiple disks
Archive files that cannot fit on a single disk are automatically split into files that 
reside on different disks if you check this option.



Clear disks before adding files
This option is significant only when creating ZIP files that span multiple disks. In 
other words, this option is consulted only when you are adding files and only if the 
"Span multiple disks" checkbox is checked.

Recurse folders
Determine whether it should include the contents of folders or not.

Move files
Check this option to delete the added and updated files (and directory) after 
compressing.

Include directory entries
Determine if it should include entries for directories in the archive. This option is 
particularly useful when the "Recurse folders" is checked. By checking this "Include 
directory entries" checkbox, even empty directories will be added to the archive, 
assuring that the entire directory structure can be recreated by extracting the 
contents of the archive.

Include volume label
Determine if it should add the volume label as an entry in the archive file. This option 
is ignored in update and freshen mode.

Include hidden files
Determine if it should include hidden and system files when adding to the archive. 

IMPORTANT NOTE

· ZIP file that spans multiple disks cannot be modified (added, updated or freshen) anymore.
· The temporary directory for ZIP operation is your default Windows directory (usually "C:

\WINDOWS"). The temporary archive file has the filename _Zxxxxxx, where xxxxxx is a unique 
random number. if a system crash or reboot occurs before the operation terminates, the temporary 
file will be left lying about, and must be removed manually.

· The default base directory for adding operation is the active directory. So the path stored in the ZIP 
file will be relative to the active directory.



Extract ZIP contents

You can easily extract files from a ZIP file directly by right clicking the ZIP file on the file list box then 
select "Extract ZIP".

You may configure the extraction settings as you like.

Tip: you may press F3 to open a dialog to select file/directory faster

Action Extract all files
All the files are extracted from the archive, into the specified extract directory.

Update existing files
Same as "Freshen existing files", but also extracts files that do not already exist.

Freshen existing files
Only files to extract from the archive that are more recent than those already existing 
in the extract directory are extracted. Files that only exist in the archive but not in the 
extract directory are not extracted.

Password Enter global password to decrypt files in the archive. If you use different passwords 
for every file in the archive, you will be prompted again for each password.

Options Overwrite existing files
Check this option to always overwrite existing files without prompting.

Use folder names
If pathnames have been stored in the archive along with the filenames, the files will 
be extracted into those paths, starting relative to the current extract directory.

Extract selected files
To extract only the selected files using wildcards. For example: *.gif or *.jpg.



View ZIP contents

To view ZIP contents, just right click the ZIP file and select "View ZIP". Multimedia Manager will display 
the list of files in the archive on the display panel. You can see the file name, size, packed size, 
compression ratio, last modified date, status, and zip comments. Click the column header to sort the 
items.

Right click to display pop-up menu like this:

Extract Selected Files
Extract all selected files in the archive.

Delete Selected Files
Delete all selected files from the archive

Select All
Select all files in the archive

Select Files
Select certain files in the archive



Viewing file as text/binary

Since version 2.0 you can view any file directly either in text or binary mode quickly. To do so, just right 
click the file name and select "View As Text" to view the file as text or select "View As Binary" to view it as 
binary. However, the viewed file cannot be edited.



View images as slide show

To view images in the current directory as slide show quickly, select "Tools - Slide Show".

To create a slide show of your favorite images, put the files in the list box then click the hand button and 
select "Slide Show".

You can save the list box contents by    clicking the hand button and select "Files - Save To File". This will 
save your favorite images to a collection file. So the next time you want to view them again, just select 
"Files - Load From File" to load them to the list box and select "Slide Show" again to view the images in 
slide show mode.

In slide show mode, you can control the slide show by using your keyboard or your mouse. To display the 
next slide, double click the image or press Enter. Press Esc to stop the slide show.

For more advanced commands, right click your mouse on the screen to popup a slide show menu.



Sending files as e-mail attachments

To send files as enail attachments quickly, right click the selected files and select "Send As Attachments". 
You will see this dialog:

Enter the appropriate information needed (recipient address, cc, subject, message) then press Send 
button to send the e-mail along with the attached files. 



Creating thumbnail images for web page

To create thumbnail images for your web page, follow these easy steps:
· Select the images you want to use as thumbnails (usually GIF or JPG)
· Select "Convert Images" from File menu
· Check the "Resize Image" checkbox and set the thumbnails size you want (assume that your images 

have similar size)
· Or, check the "Resize Image Proportionally" if you want to resize the images proportionally (e.g. 50% 

from their original size)
· Set other settings you want (image format, save resolution, etc)
· Press "Convert" button to start converting the images to a smaller size



Browsing images quickly

If you have a lot of images in a directory mixed with other file types, sometimes it's difficult to view the 
images quickly. In this case, the Auto Skip feature will be useful to help you.

Press  buttons on the image toolbar to load previous/next image quickly.



Where to get the latest version?

To obtain the latest version of Multimedia Manager, point your browser to our web site:
Tropical Wares http://tropicalwares.com

Alternatively, you can also get it from these sites:
ZDNet http://www.hotfiles.com
Simtel.Net http://www.simtel.net

Since we are improving Multimedia Manager continuously, please check the above sites often to ensure 
you always have the latest version, at least every one or two months. Thanks.




